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The PULP is published monthly by and for members of the Hartford User 
Group Exchange, Inc. (HUGE). HUGE is a nonprofit organization whose 
aim is to provide an exchange of information between users of personal 
computers. The PULP is not in any way affiliated with any computer 
manufacturer or software company. Original, uncopyrighted articles 
appearing in the PULP may be reproduced without prior permission by 
other nonprofit groups. Please give credit to the author and the PULP, and 
send a copy to HUGE. The opinions and views herein are those of the 
authors and not necessarily those of HUGE. Damages caused by use or 
abuse of information appearing in the PULP are the sole responsibility of 
the user of the information. We reserve the right to edit or reject any articles 
submitted for publication in the PULP. Trademarks used in this 
publication belong to the respective owners of those trademarks.

MEETING LOCATIONS
East Hartford Public 

Library 
Main & Central Avenue 

in the Lion’s 
Room(downstairs)

Wethersfield Public 
Library 500 Silas Deane 
Hwy., Wethersfield, CT

It’s that season again, and I’m talking about the 
other one--taxes. Our own Charles Gagliardi will 
be talking about the current crop of tax prep 
software.

In upcoming months we’ll revisit preventive 
computer maintenance and wireless home 
networking.

BTW--If you missed the meeting, on page 8 is a 
list & links to some of the geeky gifts.

Stuart Rabinowitz
Editor-in-Chief

Income Tax Software

Currently, more than two dozen tax software programs are 
commercially available. Offering range from free programs 
available at www.irs.gov to complete accounting programs 
that include tax preparation as part of their features. The 
presentation at the January meeting will cover:

• IRS data on how people file their taxes 
• Electronic Filing " e-File and Modernized e-File 

#MeF$ / state e-file requirements 
• Differences between home and professional packages 
• Types of returns " Range of examples / which 

packages do which forms 
• Brief demo - full-feature tax program #Drake Software$ 
• Demo - TaxACT Home Edition

About the presenter
Charles Gagliardi is the Treasurer of HUGE and has 
worked as a tax preparer for four years. He is familiar with 
several tax software programs. Charles is a member of the 
National Association of Tax Professionals. In 2008, he 
became an Enrolled Agent and is now authorized to 
represent taxpayers before the IRS.
 

Editors Corner

Please note that the clubs PO Box has been closed. When 
membership renewals go out in the fall the return address 
will be that of our Membership person Richard Sztaba. 

Here is the approriate copyright citation and a 
link to the full text. articles from “Tidbits”

http://creativecommons.org/licenses/by-nc-
nd/3.0/
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A Little Computer Quiz
by Stuart Rabinowitz

The trivia and minutiae of the computer 
related world. The answers will appear 
next month or you can submit an answer 
sheet at the General Meeting. Good Luck.

1  Who was the first (based on the fact 
that he got caught) to succeed in illegally 
electronically transferring a large sum of 
money from a major bank? When and 
how much?

2  Who was the first person to invest in 
Google and how much?

3  When did Apple discontinue the 
Apple II line?

4  In February 1985 someone confirmed 
that it is possible to electronically 
eavesdrop on the signal between a 
computer and the CRT. Who?

5 What does the "i" in iMac refer to?

Answers to , 2008 Quiz

1  What do the following computer software 
companies have in common? 

Central Point Software, Delrina, PowerQuest, 
Brightmail, PowerQuest, & Peter Norton Computing
  A Beside the fact that they no longer exist as 
independent companies, they have all been acquired 
by Symantec

2  What is a "jumper"?
  A  A small plastic connecter that fits over 2 (pins) on a 
motherboard to complete an electrical connection.

3  Who made the first jumperless motherboard?
  A  Abit

4  What is "a programming library for terminal-
independent cursor movement" called in UNIX?
  A  Unix Curses

4  The initial chip designed was called the 1201 and 
was later renamed when it was first released 
commercially in 1972. What was the renamed chip 
called?
  A  It was the Intel 8008, the basis for the x86 
architecture. CTC gave the rights to Intel.

 On December 18, a couple of days 
after the last meeting, Majel Barrett 
Roddenberry passed away. For 
those of you that do not recognize the 
name, she was the voice of the 
computer in “Star Trek” through all six 
TV series and several of the movies. 
As an actress she appeared in the 
original pilot, three of the series, a fan-
based internet spin-off, and several of 
the movies.
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More Photo Backup Options While Traveling
-----------------------------------------
  by Adam C. Engst <ace@tidbits.com>
  article link: <http://db.tidbits.com/article/9732>

  You're planning a big trip, and you know you'll be 
taking lots of photos with your digital camera. 
What's the best way to protect  those photos while 
you're away from home and your normal backup 
gear?

  In "Backing up Photos While Traveling" (2008-08-11), I 
shared my  thoughts about how to back up while 
traveling, including the  following:

<http://db.tidbits.com/article/9728>

* Internet Backup: If you can be certain of finding an 
Internet  connection with high-speed upload 
capabilities on a regular basis,  uploading photos to 
a photo sharing site like Flickr or to a server  you 
control is a great way to ensure that disaster cannot 
claim your  photos.

* iPod Storage: Although it's slow and limited, 
Apple's $29 iPod  Camera Connector could be a 
good solution if you happen to have a  supported 
iPod model.

* Mac Storage: We settled on the blindingly obvious 
approach of  copying photos from our cameras to 
my MacBook every night, leaving  the photos on the 4 
GB SD cards as well, so we had two copies in 
separate locations at all times. This worked well on 
this trip, but  would have fallen down if we'd been 
gone much longer (since my  MacBook didn't have 
much more free disk space) or if I hadn't wanted  to 
take the MacBook at all.

  Ever-alert TidBITS readers immediately sent me 
email with several  other solutions that they've 
employed over the years. Depending on  your 
situation, one of these might be just what you need 
on your  next trip.

**Recordable Disc** -- David Malin suggests bringing 
a number of  recordable CDs or DVDs along with 
self-addressed envelopes. Then, whenever you have 
enough photos to fill up a CD or DVD, you burn a
  disc, pop it in the envelope, add postage, and mail 

it home. This  approach would require 
bringing a laptop, of course, but it  eliminates 
the disk space concern. Eric Watson worked 
around the  need for the laptop by finding a 
shop down the street that would  burn his 
photos to DVD for a few bucks. I'd be leery 
of depending on  there always being such a 
shop down the street, though it could work  
if you're mostly staying in one place. I'd also 
be concerned about  the effort of figuring out 
the necessary postage and mailbox  
locations, but even having the photos on disc 
would meet my goal of  two copies in 
separate locations.

**Hard Disk-Based Photo Wallet** -- Lynette 
Kent and Rick Redfern  enthusiastically 
recommended the PhotoSafe II and Picture 
Porter  Elite from Digital Foci, and Dale Gould 
pointed me to what look like  similar devices: 
the NexTo eXtreme ND2700 Portable Storage 
Unit and  the Vosonic VP8860 Multimedia 
Viewer Recorder.

<http://www.digitalfoci.com/photo_safe.htm
l>
<http://www.digitalfoci.com/picture_porter_
elite.html>
<http://www.mydigitaldiscount.com/Categor
yProductList.jsp?cat=Browse+By+Brand%3ANe
xtTo:NexTo+eXtreme+ND-2700>
<http://www.mydigitaldiscount.com/Categor
yProductList.jsp?cat=Browse+By+Brand%3AV
osonic:Vosonic+VP8860+Multimedia+Viewer+
Recorder>

  The PhotoSafe II and the NexTo Extreme 
basically let you copy memory  cards to the 
device's internal hard disk; they have only 
small  text-based LCD screens that provide 
feedback. In comparison, the  more-capable 
Picture Porter Elite and Vosonic Multimedia 
Viewer  Recorder provide color LCDs that are 
larger than those in cameras
  for viewing your photos; they can also play 
and record audio and
  video, play FM radio, and print directly to 
printers. All these
  devices have rechargeable lithium-ion 

cont. on pg. 8
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E-Mailing Photographs
By Richard Kennon, Editor, Amador 
Computer Users Group, CA
www.acug.net
Drtrdguy(at)volcano.net

Obtained from APCUG with the author's 
permission for publication by APCUG 
member groups.

First, we must understand that photograph 
(image) size in the camera and in the 
computer is measured in pixels. These 
are the basic dots of color that make the 
picture. Do not pay any attention to 
anything that says “inches” or “pixels per 
inch.” These terms are meaningless when 
we are considering a picture either in the 
camera or in the computer. They may 
come into play later if we want to print the 
photo on paper. But, that is another subject 
for another time. For now, we think only of 
pixels. Most cameras record too many 
pixels to e-mail. For instance a 6 
megapixel camera will make a picture 
about 3000 pixels wide by 2000 pixels tall 
and the file size may be several 
megabytes. Our screens are usually only 
about 1000 pixels wide (some are larger 
and some smaller). So, if we e-mail the 
native picture, it will be wider than the 
screen for the recipient and the file will be 
so large, it may take “forever” to download 
to the recipient’s computer. It is possible 
the service provider will not even accept it.

There are two things we must do to make 
a photo e-mailable. The first is to resize or 
resample the picture. We want to change 
the picture width from 3000 pixels to 800 
pixels, for instance. This process is called 
resizing or resampling. We have to pick the 
best 800 pixels out of the 3000 to 

represent our photo. Well, no, that is not exactly 
correct but it simplifies things to think of it that 
way. We don’t have to worry about it because a 
lot of very smart programmers have developed 
ways (algorithms) to help us. Just remember, 
you want to resize or resample to get the photo 
down to a size convenient for e-mailing. I 
usually use 800 pixels or 900 pixels width for 
pictures I attach to e-mails.

The second thing to do to make a photo e-
mailable is to save it in JPEG format (.jpg). That 
is a format that reduces file size a lot and 
picture quality a little so the picture can be 
downloaded more quickly and still be nice to 
look at. Some software programs give you 
choices of compression amount with numbers 
ranging from 1 to 10. One will result in a very 
small file but the picture quality will not be good 
at all. A 10 will give the very best quality but with 
a very large file size. A reasonable compromise 
is to use 5 or 6. I usually use 6.

How do you do this? First, I will describe how to 
do it with a free Microsoft program. Then I will try 
to look at some other programs.

Microsoft Power Toys for XP has a Resize 
Pictures toy that is slick and easy but feedback 
says it only works on XP. It can be downloaded 
at 
http://www.microsoft.com/windowsxp/download
s/powertoys/xppowertoys.mspx. Right click on 
an image name or thumbnail in Explorer or My 
Computer and choose Resize Pictures. You 
are limited to four specific sizes but they are 
good choices. They don’t tell us what 
compression they are using but the results look 
OK. Unless you tell them under Advanced to 
replace the image in the file, it will make a copy. 
That’s good. They will add the word, “Large”, 
“Medium” or “Small” to the end of the name you 
have chosen.

cont. pg. 9
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Apple Bytes
Laptop Battery Maintenance Procedures
By Norm Kronenberg, Macintosh Director, Hilton 
Head Island Computer Club
http://hhicc.org
nkron (at) roadrunner.com

This article has been obtained from APCUG 
with the author’s permission for publication by 
APCUG member groups; all other uses require 
the permission of the author (see e-mail 
address above).

Standard Maintenance
For proper maintenance of a lithium-based 
battery, it’s important to keep the electrons
in it moving occasionally. Apple does not 
recommend leaving your portable plugged in all 
the time. An ideal use would be a commuter 
who uses her MacBook Pro on the train, then 
plugs it in at the office to charge. This keeps the 
battery juices flowing. If on the other hand, you 
use a desktop computer at work, and save a 
notebook for infrequent travel, Apple 
recommends charging and discharging its 
battery at least once per month. Need a 
reminder? Add an event to your desktop’s iCal

Calibrate battery
PowerBook G4 (15-inch Double-Layer SD), 
MacBook (all models), MacBook Pro (all 
models), and MacBook Pro (17-inch) (all 
models). 

The battery calibration for the PowerBook G4 
(15-inch Double-Layer SD) and any model of 
MacBook or MacBook Pro has been updated 
because of a new battery released with this 
computer. With these computers, follow these 
steps to calibrate your battery: 

1. Plug in the power adapter and fully charge 
your PowerBook’s battery until the light ring or 

LED on the power adapter plug changes to 
green and the onscreen meter in the menu 
bar indicates that the battery is fully 
charged.
2. Allow the battery to rest in the fully 
charged state for at least two hours. You 
may use your computer during this time as 
long as the adapter is plugged in.
3. Disconnect the power adapter with the 
computer still on and start running the 
computer off battery power. You may use 
your computer during this time. When your 
battery gets low, you will see the low 
battery warning dialog on the screen.
4. Continue to keep your computer on until 
it goes to sleep. Save all your work and 
close all applications when the battery 
gets very low, before the computer goes to 
sleep.
5. Turn off the computer or allow it to sleep 
for five hours or more.
6. Connect the power adapter and leave it 
connected until the battery is fully charged 
again.
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Vanity Spreads to Top-Level Domain Names
----------------------------------------
  by Glenn Fleishman <glenn@tidbits.com>
  article link: <http://db.tidbits.com/article/9669>

  We all know about _vanity_ domain names - 
www dot yourname here dot com, org, net, info, or 
otherwise. The Internet authority that oversees 
domain names is about to let you get a little more 
top-heavy with your vanity, if you have deep 
enough pockets.

  ICANN (Internet Corporation for Assigned 
Names and Numbers) has voted to move forward 
on allowing new top-level domains (TLDs), which 
form the right-most part of a domain name, like 
.com, .uk, or .aero. The original TLDs included .gov, 
.com, and .org, and expanded to include all two-
letter country codes, such as .au for Australia and 
.nu for the island nation of Niue. (If you look at 
"www.tidbits.com", .com is the TLD, tidbits is the 
domain name registered in the .com hierarchy, and 
www is the local host name that defines a real or 
virtual server.)

<http://ap.google.com/article/ALeqM5gvve1Yb-
5RVLc0GTkIwFT6flYwvAD91HR4N80>

  For $100,000 to $500,000, a company or an 
individual could apply for a TLD. Many years ago, 
when I worked at Amazon.com, I saw that TLD 
proposals were underway, and I suggested 
Amazon sponsor .book so that an ISBN number 
plus .book would result in a search result on the 
site. That wasn't possible then, it turned out, but 
would be possible under this new regime.

  Names could be turned down in a first-pass 
review if they were offensive, violated trademarks, 
or were too similar to an existing TLD (.con for 
grifters, perhaps? :-)). There's little information now 
about how two companies that want the same 
generic TLD, like .book, would work that out. 
Bidding? First-come, first-serve? Shared 
delegated authority? These details are expected 
to be worked out between now and about April 
2009. The ICANN page on the topic is 
unfortunately quite bureaucratic and technical in 
discussing this issue.

<http://www.icann.org/topics/new-gtld-
program.htm>

  Is this change necessary? Hard to say. It can 
be quite difficult to find the appropriate 
domain name for your business, non-profit 
organization, social site, or personal domain 
because of the exhaustion of generic words, 
and the vast growth in the use of sites
  to pull in advertising dollars through Google 
AdSense and affiliate program referrals. 
Opening up new TLDs could allow ISPs and 
other organizations to build a little more 
wiggle room.

  For instance, a soccer organization could 
register .soccer, and then work with a registrar 
to allow both fans and teams to have 
domains underneath that. The related 
problem, though, is that companies controlling 
TLDs that have a relationship to their product 
might be more ready to yank domain names 
that have content or engage in behavior they 
disagree with. That might run counter to the 
rules that ICANN requires for domain name 
handling.

  I could also see some interesting 
cooperative work emerge. Say 5,000 Mac 
users wanted to register .fanboy - to take 
back the pejorative - and were willing to pony 
up $20 each, if the TLD cost were $100,000. 
That's certainly do-able.

  The proposal will also allow the creation of 
TLDs that don't use English. Domain names 
and TLDs currently are limited to a through z, 
and 0 through 9; domain names can also 
include one or more hyphens. An obscure 
system currently allows a kind of mapping for 
non-English characters and letters, and 
ICANN has been working on a way to allow 
a more straightforward encoding method. 
They started testing this in October 2007. 
(See "ICANN Tests Non-Roman Characters 
in Domain Names," 2007-10-12.)

<http://db.tidbits.com/article/9235>

  Part of the new TLD proposal would allow 
countries to request their two-letter code in 
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batteries for use away from a  computer. They 
can also connect to a Mac via USB 2.0, at which 
point  they can act as memory card readers 
and as normal external hard  drives. Prices 
depend on the size hard disk you want, ranging 
from  about $130 to $500.

  I'd be hesitant to buy one of these devices for 
a single trip, but I  like the fact that they can be 
used as battery-powered external hard  drives 
as well, since that would make them more 
generally useful  beyond travel. Lynette also 
said that the Picture Porter Elite can  copy files 
back to memory cards, which would make it 
possible to  create additional backups on 
inexpensive memory cards and mail those  
home for even more peace of mind.

characters from their native language or 
languages. The final report on that proposal 
was presented at an ICANN meeting. A draft 
report on the non-Roman character test was 
released on 24-Jun-08.

<http://www.ccnso.icann.org/workinggroups/id
n-time-table-19dec07.htm>
<http://icann.org/en/announcements/announce
ment-24jun08-en.htm>

  The real question, of course, is how long it 
takes our fearless leader here at TidBITS to 
put together enough pennies for .bits.

New iPod Touch
A Computer in Your Pocket

The iPhone 3G has gotten all of the attention, 
but the new iPod Touch is a powerful 
touchscreen computer, with Wi-Fi access to 
the Internet, but without the cell phone feature 
or GPS. It is available in 8-, 16- or 32 MB 
capacities. Connect to the Internet wherever 
there’s a wireless network. Surf the web and 
send email from any Wi-Fi hotspot. Get 
directions, check the weather, follow stocks, 
watch YouTube, and more.
The 3.5-inch touchscreen display is perfect for 
surfing the Web, watching movies and playing 
games.

from pg. 6

from pg. 4

Mini- DLP Projector
http://accessories.us.dell.com/sna/products/Projectors
/productdetail.aspx?c=us&l=en&s=bsd&cs=04&sku=22
4-0939

Polaroid PoGo
http://www.polaroid.com/pogo/us/specs.html

Novo Minoru 3D Webcam
http://www.minoru3dwebcam.com/

Cellphone Signal Extender
http://www.thinkgeek.com/gadgets/cellphone/9823/

USB Laser Guided Missile Launcher
http://www.thinkgeek.com/geektoys/warfare/8bc4/

Solio S19-B38D Universal Hybrid Solar Charger 
w/ USB 2.0 Cable (for iPod & Cell Phones)
http://www.powermax.com/parts/show/a-bet-s19-
b38d?utm_source=Pricegrabber&utm_medium=Referr
al&utm_campaign=Pricegrabber&src=pg

Giant Swiss Army Knife
http://www.thinkgeek.com/gadgets/tools/8b97/

Lapworks – Ergonomic New Laptop Desk Futura
http://www.laptopdesk.net/laptopdesk_futura.html

Flexible Chromatic USB Hub
http://www.thinktechno.com/2008/10/05/flexible-
chromatic-usb-hub-for-the-young-and-flexible/

USB Powered Retro Web Cam
http://www.fatbraintoys.com/toy_companies/jumpin_b
anana/usb_powered_retro_web_cam.cfm?source=price
grabber&utm_source=pricegrabber&utm_medium=cse
&utm_campaign=cse_November&cvsfa=1327&cvsfe=9
&cvsfp=JB015-1

http://accessories.us.dell.com/sna/products/Projectors/productdetail.aspx?c=us&l=en&s=bsd&cs=04&sku=224-0939
http://www.polaroid.com/pogo/us/specs.html
http://www.minoru3dwebcam.com/
http://www.thinkgeek.com/gadgets/cellphone/9823/
http://www.thinkgeek.com/geektoys/warfare/8bc4/
http://www.thinkgeek.com/gadgets/tools/8b97/
http://www.laptopdesk.net/laptopdesk_futura.html
http://www.fatbraintoys.com/toy_companies/jumpin_banana/usb_powered_retro_web_cam.cfm
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If you are happy with this solution, then read 
no further. But, if you want to use a picture 
editing program, maybe this will help.

In Photoshop Elements 5, click on 
Image>Resize>Image Size and this window 
will pop up. Note that there is some garbage 
at the bottom about “inches” but we will ignore 
that. First we will click the Resample Image 
box. That puts the Pixel Dimensions in play 
and that is what we want. I selected the Width 
box and changed the width to 800 pixels. 
Since the Constrain Proportions box is 
selected, that is all I have to do. 

Note, down at the bottom, that we have 
several choices of sampling algorithms. This 
is frosting on the cake. I read somewhere that 
I should use Bicubic Sharper when 
downsizing so that is what I do. Most 
programs don’t give us all these choices. 
Then we should click on File>Save As and 
give the photo a new name. I often just use 
the same name and add “_800px” so the next 
time I will know it is ready to e-mail. Here we 
can choose the JPEG format and the 
compression amount. Photoshop Elements 6 
is out now and sells for about $100. If you are 
able to spend that much and want one of the 
best editing programs, I highly recommend it.

Let’s look at Picasa2. It is a free program from 
Google and looks really good but I do not have 
much experience with it. By all means, try it 
first because the price is right! When it comes 
to e-mailing photographs, it is a little more 
automated but not any easier to use than 
Elements. First, click on Tools>Options>E-
Mail. Then select the width you want in pixels. 
There are six choices. Then click on Apply 
and OK. 

The next step is to click on File>E-Mail and you 
will get three choices of how you want to e-
mail your photos. Fortunately, I use Outlook 
Express so my choice is listed.

When I clicked on Outlook Express, an e-mail 
page popped up with the photo attached. At 
this point we can write something else on the 
e-mail and send it. I recommend this so the 
recipient will know it is really from you and not 
something sent out by a virus. When I receive 
e-mails that only say “Attached”, I Delete them 
without looking at the attachment. This saved 
me one time when I received a virus from my 
sister-in-law that she did not know she sent. 
She spent weeks and dollars getting her 
computer back up. Oh, I digress. If you want to 
send more than one picture (and, who 
doesn’t?), you must select the picture and 
click on the Hold button near the bottom of the 
screen. Do this for each photo you want to 
send and they will all be attached to the e-
mail. The program automatically chooses 
JPEG format and a compression ratio but 
does not tell you. That is OK as the pictures I 
tried looked good. Picasa2 has considerable 
capability for editing photos in many respects. 
Try it!

There are many other editing programs that I 
haven’t mentioned and have no experience 
with. In all cases you want to change the 
picture’s size in pixels by resizing or 
resampling. Pay no attention to anything that 
says “inches” as that will have no meaning for 
this process. Sometime later we will talk 
about printing pictures and then we will use 
inches.

This article has been provided to APCUG by 
the author solely for publication by APCUG 
member groups. All other uses require the 
permission of the author (see e-mail address 
above).
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PULP Staff

Editor Stuart Rabinowitz
Distribution George Carbonell  

Membership: Anyone may become a 
member. Dues are  $12 per year and include a 
one-year subscription to The  Pulp as well as 
access to the HUGE Public Domain disk  
libraries and BBS. Meeting topics, times and 
places can  be found on page 1 of this issue. 

Officers & SIG Leaders  
President: George Carbonell 568–0492 george.carbonell@comcast.net 
Vice President Stuart Rabinowitz 633–9038 s.e.rabinowitz@att.net 
Secretary: Ted Bade 643–0430 tbade@cox.net
Treasurer: Charles Gagliardi 233–0370 epencil@att.net 
Director at Large: Richard Sztaba richer1@aol.com 
Web Manager: Bob Bonato wmaster@huge.org

Membership: Richard Sztaba  richer1@aol.com 
Integrated SIG: Stuart Rabinowitz  633–9038  s.e.rabinowitz@att.net 
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